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2 INTRODUCTION

PIPLATElogger is a utility program that provides an advanced set of tools for logging analog, digital, and temperature
data with all applicable products from Pi-Plates. The program will work with up to eight each of the following products:

DAQCplate
DAQC2plate
THERMOplate
ADCplate
CURRENTplate

To use PIPLATElogger you will need to connect signals to the Analog and Digital inputs of your Pi-Plate. Diagrams
highlighting the applicable inputs for each Pi-Plate can be found in the Appendix in Section 6.

PIPLATElogger is designed to run under the X-windows environment on the Raspberry Pi. It is written in Python3 using
Tkinter and PMW for the graphical user interface. Note that this software is copyright 2022 under version 3 of the GNU
General Public License. The terms of this license can be found in the Help menu or at this link:
http://www.gnu.org/licenses/gpl-3.0-standalone.html

3 REQUIREMENTS

To use PIPLATElogger you will need the following:

A Raspberry Pi running the Raspberry Pi operating system. While this program should run on any version of the
RPi, we recommend a version 3 as a minimum.

At least one DAQCplate, DAQC2plate, THERMOplate, ADCplate, or CURRENTplate from Pi-Plates. If you don’t
have one of these products yet, we invite you to visit our website at https://pi-plates.com and check them out.
Be sure to follow these instructions on how to set up your Raspberry Pi so that it can talk to the Pi-Plate.
Version 9.1 or later of the Pi-Plate Python module. Use “sudo pip install Pi-Plates” if you have a new setup or
“sudo pip install —U Pi-Plates” to update.

The PMW megawigdets. This module is included in the RPi OS but may not be up to date. PIPLATElogger will
perform the update automatically.

To fit as much information on the screen, this program runs at a fixed screen size of 1280 x 720. Therefore, it is
recommended that you use a FHD monitor (1920X1080) for the best experience. If you are using VNCSERVER for
remote access or headless operation, be sure to set the GEOMETRY option to 1280x720 or greater.

Finally, you will need to download and install PIPLATElogger:

a. Download the files from our server with:

sudo wget https://pi-plates.com/downloads/ PIPLATElogger.tar.gz

Then decompress them into your home directory: sudo tar -xzvf PIPLATElogger.tar.gz
Change to the Applications folder with: cd Applications

d. Open a terminal window and launch the program with: python PIPLATElogger.py

o T

4 MAIN SCREEN ELEMENTS

The opening screen of PIPLATElogger is shown in Figure 1 below. There are five primary areas highlighted:

1)

2)

Menubars: this is where you’ll open log files, make and save global setup values, start and stop data logging and
view your data. All of these options are covered in excruciating detail below. Black menu words trigger drop-
down menus while the colored menu items trigger actions.

Tabs: PIPLATElogger will display a selection tab for each compatible Pi-Plate on the stack. To see the real time
data from a particular Pi-Plate or to change the selected channels, just click its tab.



3) Bulk Channel Controls: these two buttons provide a simple means of selecting or deselecting all of the input
channels on the selected Pi-Plate.

4) The Channel Select Box / Name / Current Value: these three fields are displayed for each input channel on the
selected Pi-Plate.

a. By checking a channel select box, you will be able to monitor its value in real time on the Input Window

to the right as well as saving the values to a file when a logging session is executed.

b. The channel name field can be changed to reflect a more descriptive name of your input signal. This
name will be saved to the log file along with the data. To modify, just click anywhere in the text box to
edit the default title.

c. The value shows the current measurement of a channel if it is enabled.

5) Input Widows: these are mini real time plots of each selected channel. There are approximately 600 points on
each graph with the newest data appearing on the right and old data sliding off to the left. Different Pi-Plates
display different data types depending on their capabilities.
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Figure 1

5 OPERATION

There are three operational modes when using PIPLATElogger: Idle/Setup, Logging, and Viewing Logged Data.

5.1 IDLE /SETUP
This is the default mode for PIPLATElogger. It is here where you can select the channels you wish to monitor, change
their names, create a logging file, test your setup, save and restore configurations

5.1.1 Logging Setup
There are three steps for creating a log:

1) Create or open a log file
2) Select the sample rate and sample count for your log
3) START the log

5.1.1.1 Saving to a File
To save your log to a local file, click on LOG SETUP->0Open New File for Logging:
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Figure 2

A new dialog box will pop up and prompt you to enter the name of your new log file. You can also over write an existing
log file. Note that all log files are automatically assigned the extension “csv.” Once you have typed in or selected your
file, click the Save button. If you chose to over write an existing file, the system will ask you to verify this action. When
you are done with this step, the data from all selected channels will be written to this file while the program is in the
Logging mode.
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5.1.1.2 Sample Rate / Count
To change the sample period and count, click LOG SETUP -> Set Logging Parameters on the menu bar. A small menu
will pop up and you will be to modify these two values. A couple of things to note:

1) The minimum sample period is dictated by the number of Pi-Plates on your stack. A single DAQC, for example,
will require 0.2 seconds to capture all eight analog inputs, capture all eight digital inputs, and to update the data
in the PIPLATElogger window. Two Pi-Plates will force the minimum period to 0.4 seconds. Three will force it to
0.6 and so on. So, for maximum sample rates, keep your Pi-Plate count low.

2) The Log Duration is the product of SampleCount X SamplePeriod. So, if you choose a Sample Period of 1 second
and you set the Sample Count to 1000, then the logging duration shall be 1000 X 1 = 1000 seconds or 16 minutes
and 40 seconds.

Sample Period in Seconds (Minimum is 0.8} |1
Sample Count; 1000

Lag Duration in seconds = 1000.0

Close |

Figure 4
Note that the Period and Count values are part or the information saved when you choose File -> Save Configuration.

5.1.2 Channel Configuration
As mentioned previously, you can choose the channels on each Pi-Plate that you want to monitor simply by clicking the
checkbox in front of its name as shown in Figure 1. You can also edit the channel names by clicking in the text field and



changing the default entries to values that are more descriptive of their source. Your data from your selected channels
and the custom names will be saved to the log file.

5.1.3 Saving and Restoring a Configuration

In the File dropdown menu there are commands for Saving and Restoring the Configuration. This is a pretty handy
feature if you have a setup that you plan to use repeatedly. The configuration will include the selected channels, their
names, the sample period, the sample count, and your optional streaming parameters.

Be advised that if you save a configuration and then modify your stack by adding or removing a Pi-Plate, PIPLATElogger
will show an error message when you try to restore that old configuration.

5.2 LOGGING DATA

The moment has finally arrived! You've created a log file and set up you sample time and count. Maybe you selected and
renamed specific channels as well. It’s logging time. Just click the word START on the menu bar and PIPLATElogger will
start saving data to your selected file. The status of the logger along with the remaining number of samples and time to
completion will be displayed in the title bar of the program as shown in Figure 5. After the logging has completed, you
will be alerted with the message shown in Figure 6

If for any reason you want to halt the logger then simply click on the word STOP in the menu bar.
A few things to note:

1) If you stop a log and then click START again, the data previously saved to your log file will be lost. To avoid this,
choose a new log file before starting another session.
2) While logging, most menu items are disabled.
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FILE LOG SETUP START STOP VIEW HELP

DAQC2-0 CURRENT-0 ADC-0/1 ADC-0/2

Clear All Select All
| @ |A channel 0:  -4.389
| @ |achannel 1:  1.441
n Channel 2: off
n Channel 3: off
n Channel 4: off
n Channel 5: off

v A X

n Channel 6: off

I
g

(WA channel 7: off
A T T e

D Channel 2:

oo o [T L LI L L L L L L LT LT LT
s s s

n Channel 5:
n Channel &6:
n Channel 7:

Figure 6

5.3 VIEWING LOGGED DATA

PIPLATElogger saves data to files in a format called CSV or Comma Separated Variables. This format makes it easy to
open and edit with a simple text editor. CSV files can also be imported into many popular spreadsheet programs such as
LibreOffice Calc.

The program provides two methods to view your log data. To access these, click VIEW on the menu bar. The following
buttons will then pop up.

View Data File
Open Data in Spreadsheet

Figure 7

Be advised that some of the VIEW options can cause the logging process to pause.

5.3.1 File
Clicking the View Data File and following the prompts allows you to view your raw log data using the text editor that
comes installed on the Raspberry Pi OS (Figure 8).

The first line of text is the channel names while the remaining lines are a time stamp followed by the channel data.
Analog data is represented by numbers in a decimal format (3.82, 2.96, 1.00, etc.) while the digital input data is
represented by ones and zeros.



While you can edit this file, be careful not to delete any of the commas separating the data. Otherwise, you won't be
able to plot it correctly using the built in Plot program or open it with LibreOffice Calc.

Pi-PlateData csv

File Edit Search Options Help

(Time, DAQC2-8-A Channel 0:,DAQC2-0-A Channel 1:,DAQC2-0-A Channel =
|2:,DAQC2-0-A Channel 3:,DAQC2-0-A Channel 4:,DAQC2-0-D Channel
|@:,DAQC2-8-D Channel 1:,DAQC2-0-D Channel 2:,DAQC2-0-D Channel 3: ‘
12019-07-21-11:33:57,2.774,3.518,3.19,-0.244,8.97,1,0,1,0

12019-07-21-11:33:58,2.776,3.518,3.175,-0.251,2.823,1,0,1,
2019-07-21-11:33:569,2.779,3.517,3.16,-0.258, -3.132,1,0,1
(2019-67-21-11:34:00,2.779,3.52,3.148, -0.262, -9.56,0,0,1
(2019-607-21-11:34:01,2.788,3.528,3.137, -0.263,-2.474,0,0
12019-07-21-11:34:02,2.792,3.534,3.127,-0.261,4.05,0,0,1
(2019-607-21-11:34:603,2.801,3.54,3.11, -0.259,7.926,0,0,1,
(2019-687-21-11:34:04,2.799,3.539,3.098,-0.26,1.164,1,1,0,0
(2019-07-21-11:34:05,2.799,3.543,3.084, -0.264, -5.042,1,1,0

1,0

G,0

G]
0]

0]
1,0
0]

, 0,0
12019-07-21-11:34:06,2.806,3.544,3.066, -0.265,-7.826,1,1,0,0
(2019-07-21-11:34:607,2.81,3.552,3.0563,-0.262,-0.71,1,1,0,
(2019-67-21-11:34:08,2.815,3.559,3.043,-0.256,6.274,0,1,0,0
(2019-07-21-11:34:09,2.82,3.559,3.026,-0.253,5.935,0,1,0,0
[2019-607-21-11:34:10,2.822,3.562,3.011,-0.252,-0.296,0,1,0,0
(2019-607-21-11:34:11,2.822,3.561,2.993,-0.25,-5.943,0,1,0,0
(2019-67-21-11:34:12,2.829,3.566,2.98,-0.245,-6.064,1,0,0,0
[2019-87-21-11:34:13,2.838,3.572,2.97,-0.235,0.232,1,0,0,0
(2019-07-21-11:34:14,2.841,3.578,2.959,-0.223,8.178,1,0,0,0
(2019-607-21-11:34:15,2.841,3.578,2.942,-0.217,4.306,1,0,0,0
(2019-67-21-11:34:16,2.845,3.583,2.922,-0.213,-1.259,0,0
(2019-607-21-11:34:17,2.846,3.581,2.906, -0.209, -8.128,0,
12019-07-21-11:34:18,2.857,3.585,2.889, -0.194, -5.066,0
(2019-607-21-11:34:19,2.863,3.593,2.878,-0.18,2.254,0,0
|2019-67-21-311:34:20,1.711,1.715,1.708,1.712,8.973,1,1,
(2019-67-21-11:34:21,1.711,1.723,1.725,1.748,3.566,1,1,1,
12019-07-21-11:34:22,1.713,1.727,1.741,1.78,-3.442,1,1,1,
(2019-07-21-11:234:23,1.719,1.739,1.758,1.819,-8.9,1,1,1,1
(2019-687-21-11:34:24,1.726,1.748,1.779,1.863, -2.94,0,
(2019-607-21-11:34:25,1.731,1.764,1.8603,1.902,3.693,0,
12019-07-21-11:34:26,1.737,1.772,1.825,1.943,8.182,0,
12019-607-21-11:34:27,1.737,1.778,1.84,1.979,1.99,0,1,1,
2019-67-21-11:34:28,1.742,1.786,1.858,2.016, -4.238,1,0,1,1
(2019-07-21-11:34:29,1.745,1.796,1.874,2.054,-8.694,1,0,1,1
12019-07-21-11:34:30,1.754,1.809,1.898,2.089,-1.672,1,0,1,1
(2019-07-21-11:34:31,1.759,1.819,1.918,2.132,5.398,1,0,1,1
[2019-67-21-11:34:32,1.763,1.832,1.936,2.173,6.394,0,0,1,1
(2019-07-21-11:34:33,1.768,1.835,1.956,2.206,0.595,0,0,1,1
(2019-07-21-11:34:34,1.77,1.843,1.97,2.239,-5.645,0,0,1.1
(2019-07-21-11:34:35,1.776,1.857,1.992,2.277,-7.183,0,0,1,
(2019-67-21-11:34:36,1.784,1.867,2.013,2.317,0.425,1,1,0,1
|2019-87-21-11:34:37,1.79,1.878,2.039,2.359,7.078,1,1,0,1
(2019-607-21-11:34:38,1.795,1.888,2.053,2.393,5.244,1,1,0,1
12019-07-21-31:34:39,1.795.1.894,2.07,2.429.-0.982,1.1.0.1

Figure 8

5.3.2 Spreadsheet

The final button, Open Data in Spreadsheet passes the selected log file to LibreOffice Calc. When this occurs you will be
prompted to choose the delimiter that separates the data in your file as shown in Figure 9. Click the checkbox in front of
“Comma” followed by the OK button. Your log file data will now be presented to you in tabular form.



Text Impart - [Pi-PlateData.csv] —~ O %

Import
Character set: EéUnicode (UTF-8) .|
Language: \Default - English (USA) o
From row: 1 =l
Separator Options
() Fixed width (&) Separated by
Wl Tab v Comma » Semicolon (] Space (] other ‘ ‘
(] Merge delimiters Text delimiter: ‘ |
Other Options
(] Quoted field as text (] Detect special numbers
Fields
Column type | - |
Standard lStandard IStandard |Stan|“
1 [Time DAQC2-0-A Channel ©: DAQC2-0-A Channel 1: DAQC
9 2019-07-21-11:33:57 2.774 3.518 3.1¢
3 2019-07-21-11:33:58 2.776 3.518 3.17
4 2019-07-21-11:33:59 2.779 3.517 3.1€6
5 2019-07-21-11:34:00 2.779 2, 52 3.14
' f 2019-07-21-11:34:61 2.788 3.528 8.1%
7 2019-07-21-11:34:02 2.792 3.534 3.1z
'8 2019-87-21-11:34:83 2.801 3.54 3.11
g 2019-07-21-11:34:04 2.799 3.539 3.0¢
;_..nr_\qn A7 A4 44 -94-AC A TN S C AN - n'c*"
Help OK || Cancel

Figure 9

By using Calc, not only is your data organized and viewable in a nice clean format but it’s also possible to plot it out using
a number of different formats. For example, while holding down the shift button, click on columns headers A, B, and C.
(Figure 10) Then click on the Plot Functions Icon. A preliminary plot will appear but we’re going to create a simple line
graph. Choose that now and then stick with all of the default values. When finished, you should have a graph similar to
Figure 11
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6 APPENDIX

The diagrams below highlight the inputs that can be logged for each Pi-Plate.
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6.2 DAQC?PLATE
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6.3 THERMOPLATE

Thermocouple Inputs

Figure 14
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6.4 ADCPLATE
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CURRENTPLATE
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